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1 Introduction 
The Guideline Markup Tool (GMT) has been initially developed to support knowledge engineers in 
translating plain-text clinical guidelines (available as HTML files) to Asbru XML files by providing 
so-called "macros" each combining one or more Asbru elements together with their attributes. As a 
second main feature, it allows to establish and maintain connections (called links) between the 
original guideline and the Asbru representation. GMT 2.0 has been designed to additionally support 
any arbitrary XML language (in the context of the Protocure II project, this will especially be Asbru, 
8HB and KIV-XML) and to permit links also between two XML files (or even between two HTML 
files). Besides these two main features, GMT 2.0 is now a full-featured XML editor (even with 
some special features, which no common XML editor provides). 
 
The GMT is a Java application and should therefore run on (almost) any system. It has been 
extensively tested on Windows (Windows 2000 and Windows XP), but it should also run under 
Linux or MacOS, although I cannot guarantee that its behavior is the same on those systems. 
 

1.1 Short Overview of Features 
 Open two XML/HTML – Files at the same time 
 Links between XML/HTML – Files 
 XML – Macros  
 Custom XML-Languages support 
• Convert original DTD to link-enriched DTD 
• Auto-recognize XML-Language on load of XML file 
• For each XML-Language Templates, Icons and the following special "Views" can be 

defined: 
 Highlight result of XPath expression 
 Filter: Show/Hide result of XPath expression 
 Folding: Expand/Collapse result of XPath expression 
 Apply XSL-File for information extraction 

 Project: combines two XML/HTML files and a macro file 
 Standard XML-Editor Features: 
• Change, Add or Remove Attributes 
• Insert arbitrary valid XML elements (and comment and text nodes) 
• XML-Clipboard: Cut/Copy/Paste of XML-Nodes – also between two (opened) XML files 
• Validate XML-Document against DTD 
• Change comment / text node value 

 4 Insert Modes when inserting with "Macro Insert", Paste or "Insertable Elements Dialog": 
Insert Into/As Child, Insert Before, Insert After, Replace; plus 2 additional insert modes for 
inserting elements: Convert and Wrap (see page 7) 

 Undo / Redo of every action 
 XPath-Bar: shows XPath expression for current XML node and allows easy evaluation of any 

XPath expression 
 Treepath-Bar: "Jump-To" buttons for each element in the path to the current XML node 
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2 Installation 
There are two ways of installing and running the GMT, either (i) by downloading the necessary 
files and executing it locally or (ii) by using Java Web Start (JWS). For both, a properly installed 
Java Runtime Environment (JRE), version 1.4 or higher, is needed. If you have not installed a JRE 
yet, you have to first download and install the appropriate JRE setup from 
http://java.sun.com/getjava/manual.html.  

• Install manually:  
Download an archive containing all necessary files to start the GMT plus some sample files, 
http://www.asgaard.tuwien.ac.at/~peter/GMT/download/gmt.zip (Windows) or 
http://www.asgaard.tuwien.ac.at/~peter/GMT/download/gmt.tar.gz (Linux), each has 
about 3.0 MB. 
Then uncompress the downloaded package to a new directory. The directory will then 
contain the following files and folders: the GMT executable jar file, shell scripts to start the 
GMT, a config file that cause the GMT to start up with a sample project, a samples folder 
that contains sample HTML, XML, macros and project files, a xmlLanguages folder that 
already contains definitions for 8HB and Asbru and a licenses folder that contains license 
text files that are demanded to be re-distributed by the used Java libraries. 

• Java Web Start: When using JWS, you are always up-to-date, using always the latest GMT 
version. First, you have to install JWS. If you have downloaded and installed the JRE, you 
have already got the JWS setup, which is located in your JRE directory (e.g. C:\Program 
Files\Java\j2re1.4.1\javaws-1_2-windows-i586-i.exe). 
After installing JWS, go to the GMT homepage and click on the  Launch GMT  button. The 
JWS-Application Manager downloads all necessary .jar-files. Before the GMT will be 
executed the first time, you will be asked if you grant the GMT access to your computer's file 
system. The next time, you can start the GMT in the JWS-Application Manager, or, much 
easier, you can create a desktop-link to the JWS version of the GMT (in the Java Web Start-
Application Manager select the GMT and go the "Applications" menu and choose "Create Link") 
and start it without executing the JWS-Application Manager. Every time you start the GMT 
this way, the JWS-Application Manager automatically checks if there is a newer version 
available. 
 
Note: If your browser complains he does not know what to do with a .jnlp file, you have to register a new 
MIME-type in your browser: 

 

Name:  JNLP File 
Extension:  jnlp 
MIME-Type:  application/x-java-jnlp-file 
Application:  path to javaws.exe,  

e.g. C:\Program Files\Java Web Start\javaws.exe

http://java.sun.com/getjava/manual.html
http://www.asgaard.tuwien.ac.at/~peter/GMT/download/gmt.zip
http://www.asgaard.tuwien.ac.at/~peter/GMT/download/gmt.tar.gz
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3 Getting Started 
If the GMT has been installed, it can be started using the enclosed batch script gmt.bat (Windows) 
or gmt.sh (Linux). Instead gmt-light.bat (or gmt-light.sh) can be used, which hides 
several advanced features and is recommended for new users. After the first start, the GMT loads a 
demo project (DCIS.project) containing three sample files (DCIS_with_links.html, DCIS.xml 
and 8HB-2.macros). The user interface can be seen in Fig. 1. 

4f4e 4d4c4b
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4a 

2 
1 

Fig. 1: Parts of Main Window1

Parts of GMT user interface: , : equivalent Views to either edit XML files (see section 4) or 
show HTML files (see section 7)  

: Macros part (see section 6) – a) either structure view, search view or insertable macros view, b) 
preview of the current macro  

: Status bar –  
a) info text box – shows information about menu items, buttons and current activities  
b) "Valid Mode" button – to enable/disable validity checks, which ensure that no action can 
result in an invalid XML document (is enabled by default) 
c) clipboard information – shows the last clipboard action (copy or cut) 
d) current project (see section 8.2) – double-click opens project properties dialog 
e)/f) the name of the current XML language (see section 8.3) of the left/right side – double-
click opens XML language definition dialog; right-click shows a list of all defined XML 
languages for easier switching over to another language 

Note: The size of the parts ,  and  can be easily changed by moving the divider (  or ) 
– to fully maximize or minimize click on the little-arrow-buttons ( /  or / ). 
                                                 
1 Note: The screenshots in this document have been produced using JRE 1.4.x under Windows 2000/XP. The GMT may 

look different using on Linux or Apple or with the new JRE 1.5. 



GMT  User Manual Page 5 of 27 

To start translating a guideline (HTML) to an XML language like Asbru the following initial steps 
has to be performed: First, open an HTML file. The second step is either to create a new XML file 
or to open an existing one. Finally, open an appropriate macro file. 

1) Open HTML file: Click on the  button on either the left or right toolbar or select the "Open 
…" menu item from the "Left"/"Right" menu, to show the file open-dialog: 

Fig. 2: "Open HTML File" – dialog 

Change the "Files of Type" combo box to "HTML Files", select the HTML file you want to 
open and click on the  Open  button. 

2) New / Open XML file: If you want to create a new XML file, either click on the  button on 
the toolbar or select "New …" from the "Left"/"Right" menu. A file dialog is shown where 
you can enter the new (and the location) of the new file. The "New" command is only 
enabled, if an XML-Language has already been defined (see section 8.3).  
Otherwise, click on the  button on the toolbar or select the "Open …" menu item from the 
"Left"/"Right" menu to open an existing XML file. There are three possibilities to narrow the 
list of XML files down: Either change "Files of Type" to "XML Files", which will show only 
files with the extension ".xml", or switch to "Any XML Files", which will show all XML files 
regardless of their extension. Additionally, if XML-languages have already been defined in 
the GMT, the list of files can be narrowed to show only files of a specific XML-language 
(such as Asbru or KIV-XML). 

3) Open Macro file: Click on the  button on the "Macros View" ( a) in Fig. 1) toolbar or 
select the "Open …" menu item from the "Macros" menu to show the macro file open-dialog. 
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4 XML View 
If an XML file is opened in any side (either left or right), its content is shown in a tree view as used 
in many conventional XML editors (see Fig. 3).  

 
Fig. 3: XML part: toolbar, tree view and attributes table 

The name of the current XML file is shown in the middle of the toolbar (above the tree view). If the 
current file has been changed and not yet saved, the filename is displayed using an italics font. On 
the right side of the toolbar, a set of buttons provide quick access to some useful features:  

 : Creates a new (empty) XML document; the arrow button shows a list of pre-defined 
templates for the current XML language. 

 : Shows the open file dialog to open any file (either XML or HTML); the arrow button 
provides quick access to recently opened files. 

 : Reloads the current file (and tries to retain the current selection). 
 : Saves the current file (is only enabled if changes have been made). 
 : Saves the current file under a new name (Is only enabled if changes have been made). 
 : "Go back" - Scroll to and select the previous selected element. 
 : "Go forward" - Scroll to and select the next selected element after "Go back". 

 
The XML tree view is able to represent all seven kinds of XML nodes: 

 Document node : root node of an XML document 
 DocType node:   
 Element node:  

o Top element:  
o Link element:  
o , if the XML parser reports an error, or  if the parser reports a warning 

 Comment node:  
 Text node:  
 CDATA node:  
 Processing Instruction (PI) node:  

The last three node types are rarely used and are only mentioned for the sake of completeness. 
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4.1 Standard XML-Editor Features 
One design  principle of the GMT was to reduce the need of the user to switch to another 
application (especially an XML editor) while working with the GMT. Therefore, the GMT provides 
all standard features of common XML-editors. 
1) Inserting Element: The GMT can be used to insert any valid XML element in two different 

ways: either using the "Insertable Nodes Dialog" (see Fig. 4) or using the "All Elements Dialog" 
(see Fig. 5). The "Insertable Nodes Dialog" can be opened either by using the "Show Insertable 
Nodes" menu item in the "Edit" menu or by using the keyboard shortcut Ctrl-I. 

 
Fig. 4: Insertable Nodes Dialog 

This dialog shows all nodes (elements plus comment and text nodes) that are valid to insert into 
the current XML document grouped by 6 different insert modes: 
 Insert As Child / Insert Into: Inserts the selected node as a child into the current element (at 

the last possible position). 
 Insert After: Inserts the selected node at the first possible position after the current node. 
 Insert Before: Inserts the selected node at the first possible position before the current node. 
 Replace: Replaces the current node with the selected node. 
 Convert: Changes the old element to the new one retaining all child elements and attributes. 
 Wrap: Surrounds the current element with the selected element, i.e. the new element will be 

inserted of the old element, which will become a child of the new element in return. 
 
The "All Elements Dialog" (Fig. 5) can be opened either by using the "Show All Elements" 
menu item in the "Edit" menu or by using the keyboard shortcut Ctrl-A. 

 
Fig. 5: All Elements Dialog 

This dialog shows a list of all elements that are defined in the DTD1 file. The selected element 
can be inserted based on the same 6 insert modes as described above. If the selected element is 
not allowed to be inserted regarding the current insert mode, it is crossed through. In addition, 

                                                 
1 DTD ... Document Type Definition. A DTD file defines the elements and attributes of an XML language and how they 

are structured. If an XML file contains a valid DOCTYPE line pointing to an existing DTD file, the GMT is able to 
retrieve and use information from the DTD (e.g. which elements are allowed to insert). 
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the next possible location, where the selected element can be inserted, can be searched using the 
 (search downwards) and  (search upwards) buttons. 

Note: in both dialogs, a node can be inserted not only by clicking on the insert button, but also 
by either double-clicking on the selected list item or by pressing the Return key. 

2) Remove Node: To remove an XML node, select the corresponding tree node in the XML tree 
view and click on the  button in XML node info toolbar below the tree view (alternatively the 
Del key or the "Remove Node"-menu item can be used). Note that this feature is only enabled 
if it is allowed to remove the current node according to the DTD (this validity check can be 
disabled using the "Valid Mode" button in the status bar). 

3) Attributes: If the currently selected XML node is an element, its attributes are shown in a table 
below the tree view. 

 
Fig. 6: XML Attributes Table 

a) Edit: To edit an attribute value, just click inside the value column. Common copy-and-paste 
shortcuts can be used here – for example to copy a text from an HTML file on the other 
side, select it there, press Ctrl-C and paste it here using Ctrl-V. The  button shows a 
small edit window for more convenient editing of longer attribute values. If there is a fixed 
list of attribute values defined for this attribute in the DTD, a combo-box containing these 
values is shown instead of the editing field. 

b) Add: To add a new attribute for the current element, use the combo-box below the table 
and the  button beside it – an input dialog is shown to enter a value for the new attribute. 

c) Remove: To remove the current attribute, use the  button or the Del key. This feature is 
only enabled if this attribute is not required according to the DTD (Note: required attributes 
are shown using a bold font for the attribute name). 

4) XML-Clipboard: XML nodes can be copied or cut and then pasted somewhere else (even in 
another XML file in the other side) using either the Edit menu in the main menu bar or the Edit 
sub-menu in the context menu. There are 4 insert modes for pasting the content of the clipboard 
- Paste Into, Paste After, Paste Before and Replace – that act the same as the first 4 insert modes 
for inserting elements (see previous page). Note that when using cut the chosen node will not be 
deleted until paste is invoked. After invoking copy or cut, the selected node gets a grey 
background (together with all its descendants). In case of cut, these nodes will be additionally 
shown crossed out. Note: cut is only enabled if the current node may be deleted. 

5) Duplicate Node: To duplicate the current node, use the "Duplicate Node" menu item (in the 
main menu or in the context menu) or its shortcut Ctrl-D. Note that this feature is only 
enabled if the same node may be inserted directly after itself again according to the DTD. 

6) Validate: The GMT makes use of two different methods for validating an XML document 
against its DTD: On the one hand, a validating XML parser is used that provides the GMT with 
error messages about invalid nodes on loading. Those nodes will be shown with this  icon and 
the error messages will be presented using tooltips. On the other hand, the GMT provides a 
validate feature (use either the menu item in the Left/Right menu or in the context menu or use 
the keyboard shortcut <F4>) that re-validates the internal representation of the XML document 
and highlight invalid nodes with red background color. This feature is only useful if the “Valid 
Mode” has been turned off. 
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4.2 XML View Special Features 
Besides links and macros, the GMT provides some special XML features that were also not 
available in other XML editors: 
• Treepath-Bar: This feature – activated either using the menu item "Show Treepath-Bar" in the 

View-submenu of the Left/Right menu (or in the context menu) or using the keyboard shortcut 
Ctrl-Shift-T – shows a special panel above the XML tree view that contains buttons for 
each ancestor element of the currently selected node. A sample of the treepath-bar, when an 
Asbru plan element is selected, can be seen in Fig. 7.  

 
Fig. 7: Treepath-Bar 

Clicking on one of these buttons would cause the XML tree view to scroll to the particular 
element and select it. 

• XPath-Bar: Advanced users may use XPath to deeper investigate an XML document. The 
XPath-Bar can be used to apply any XPath expression to the current XML node. Expressions 
that result in one or more nodes (like the one seen in Fig. 8) would cause the resulting nodes be 
get highlighted. Expressions, which result in a single value (e.g. count(//gmt-link), which 
would display the number of link endpoints in this XML document) are supported as well. 

 
Fig. 8: XPath-Bar 

• Folding: Folding means expanding or collapsing one or more XML tree nodes. There actions 
for expanding / collapsing all nodes of the current document, expanding / collapsing only the 
nodes of the current sub-tree in the View / Folding sub-menu. Additionally, there are two menu 
items that can be used to expand / collapse only specific nodes using XPath. Such folding XPath 
expressions can be pre-defined for each XML language. 

• Highlighting: The "Highlight result of XPath" menu-item in the View / Highlight sub-menu 
provides the same functionality as the XPath-Bar. Additionally, pre-defined highlight XPath-
expressions can be recalled in this menu. Furthermore, there are two useful highlight features 
regarding links: one allows to highlight all link endpoints in the current  

• Filter: Filters – accessible through the View / Filter sub-menu – can be used to show or hide 
specific nodes. Aside from standard filters to toggle the visibility of all types of XML nodes 
(except elements), XPath can also be used here to show or hide any arbitrary set of nodes. 
Additionally, custom filters can be defined for each XML language and recalled later here. 

• Information Extraction: This feature has already been successfully integrated in a previous 
XML editor1 developed at our institute. The idea behind it is that if an element tree-node is 
collapsed the user has apparently no information about its child nodes. The solution is to 
optionally display short information about the child nodes instead of the attributes in the tree- 
node label. XSL files are used to store the information which "data" should be extracted for 
which element. A list of such XSL files can be pre-defined for each XML language. 

• Icons: The default icon for elements  may be replaced by user-defined icons for particular 
elements of a specific XML language (e.g. for better distinction from other elements every Asbru 
plan element may get a special icon). Multiple icon-sets can be arranged and toggled using the 
View / Icon-Sets sub-menu. 

 
Those features are described in more detail in the integrated help file. 

                                                 
1 See http://www.asgaard.tuwien.ac.at/tools/pixee.html  

http://www.asgaard.tuwien.ac.at/tools/pixee.html
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5 Links 
A link1 can have one or more endpoints in each side – all of them are internally marked with the 
same unique link ID number. This means that links constitute a m:n-relationship between two files. 
The link ID number is shown in the status bar, if the mouse cursor is moved over a link end point. If 
a link endpoint is activated by clicking on it, all endpoints on the other side with the same link ID 
number will be highlighted. When the mouse cursor is moved over a GMT link endpoint (either in 

HTML or XML view), the cursor changes to .  If this link endpoint has no counterpart in the 

other side,  is used for the cursor instead. Additionally, the status bar shows information about 
this link (current link ID number and number of counterparts).  
1) Insert new Link: For both sides, you have to select the position where the two link end points 

should be inserted. In case of an XML, select the XML element, which should receive the 
special link element and in case of an HTML file, select the piece of text that should become the 
endpoint of the new link. Then choose "Create new GMT Link" from the Left/Right-menu or 
from the context menu. If a link is inserted into an HTML file, the selected text will become 
surrounded by pre-defined link delimiter characters (can be specified in the preferences dialog – 
see Fig. 18 – default values are ‘[‘ and ‘]’), see  . 

2) Insert new Endpoint: Inserting only a new end point that belongs to an existing link is quite 
similar to inserting a new link as described above. If you select an existing link in one side, then 
a target in the other side and then choose "Create new GMT Link", the created endpoint in the 
other side gets the same link ID number. To "select" an existing link in an HTML file, select 
text so that the HTML link (or only a part of it) is in the selection. 

3) Activate Link: Activating a link by clicking on it highlights all link endpoints in the other side 
with green background color. Both XML and HTML view scroll to the first link endpoint. The 
XML view additionally selects the first link endpoint. To activate a link endpoint in the HTML 
view, just click on the underlined text like in a conventional browser. For easier distinction from 
standard HTML links, the text of a GMT link end point is colored in cyan instead of blue. In the 
XML view, simply click on the link element (this can be changed to double-click in the XML 
tab of the preferences dialog, see Fig. 19). If the same link endpoint is activated again, the 
opposite side scrolls to next link end point. 
It is also possible to activate more than one link at once by using the "Activate Links" menu 
item. In the HTML view, just select a text that contains link endpoints from different links first. 
In the XML view, just select any element before clicking on "Activate Links" menu item and all 
those links will be highlighted in the other side that have counterparts somewhere in the subtree. 

4) Synchronize Links: "Synchronize" means in this context to re-map an endpoint to another link. 
This is a convenience method for changing the link ID number of a link endpoint instead of 
using the XML attributes table (see Fig. 6). Just select one link endpoint in each side and then 
invoke "Synchronize GMT Link(s)" for the side on which the link ID is to be changed. 

5) Remove End point: For an XML file, this is done the same way as removing any XML node 
(see section 4.1,p. 8,Remove Node). For an HTML file, you first have to select a link endpoint 
and then choose "Remove GMT Link(s)" from the Left/Right-menu or from the context menu. In 
contrast to an XML file, it is possible to remove several GMT links in an HTML file together – 
just select text that contains all desired links. If you want to remove only one GMT link 
endpoint, you do not need to select text – just right-click on the link and invoke "Remove GMT 
Link(s)" from the context menu. 

6) "Dead Links":  If two linked files (either XML or HTML) are opened at the same time (one file 
left and one right), it is possible, that GMT links turn to so-called Dead Links after removing 
link endpoints or synchronizing links. A Dead Link is a GMT link that has no counterpart on the 

                                                 
1 Note: A link can either connect an XML file and an HTML file, two XML files or even two HTML files. In case of an 

XML and an HTML file, it is regardless in which side the HTML file and the XML file have been opened.  
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opposite side. To remain consistency, the GMT checks for Dead Links after removing or 
synchronizing links and asks the user to remove them. This ensures that two corresponding files 
are always “in sync” regarding their links.  

7) Highlight Links: There is a feature to highlight all link endpoints in the current HTML or 
XML document and another similar one to highlight all other link endpoints that have the same 
link id as the currently selected link endpoint. Both features ("Highlight all Links" and 
"Highlight same Links") can be found in the context menu of each side. 

8) Links Visualization: This feature gives a good overview of the distribution of links inside an 
XML file. It can be activated in View-submenu of the context menu or of the Left/Right menu 
in the main menu bar. There are two different types of this feature - both use green as 
background color for link elements, cyan for parent elements of link elements, dark cyan for 
link related elements (depends on visualization type) and grey for all other elements. 
a) Visualize "GMT-Links and ancestors" (Fig. 9): All ancestor elements of every link element 

will be colored and any element that does not contain a link element in its entire sub-tree 
will be grey. 

b) Visualize "GMT-Links and descendants" (Fig. 10): All descendant elements of every 
element that is a parent of a link element will be colored and any element that has no link 
element as an ancestor will be grey. 

  
Fig. 9: Visualize "GMT-Links and ancestors" Fig. 10: Visualize "GMT-Links and descendants" 

6 Macros 
A macro defines a structure of XML elements. Instead of inserting only single elements (as in 
conventional XML editors), the usage of macros provides the opportunity to insert more than one 
XML elements at once. A macro file is again an XML file based on a self-designed XML-Language 
(see Appendix D: The Macro Language).  
The GMT contains three different views for showing the contents of a macro file: structure view, 
search view and insertable view. After loading a macro file (either by using the  button or by 
using the "Open" menu item in the "Macros" menu), the hierarchical structure of the contained 
macros is shown in the structure view (see Fig. 11).  

 
Fig. 11: Macros Structure View (& Macro Preview) 

The structure view was designed as a replacement for a tree view, which would be normally used 
for representing hierarchical data, simply because of layout reasons. If a group list item ( / ) is 
selected in the structure view, its child items are shown in the next list box to the right. 
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1) Insert Macro: First, select an element in an XML view, which should receive the contents of 
the macro. Note: If the foreground color of a macro changes to red, when it is selected, this means the 
macro author has defined this macro as not complete, i.e. the macro is missing required child elements 
or attributes. This allows simpler macro files, but would also produce invalid XML code – so the user 
has to insert the missing elements manually. Second, select an appropriate macro in the macros 
structure view that has an  icon (or  if it contains a link). A macro is marked with a /  
icon (and a darker background) to indicate that it is not allowed to be inserted into the currently 
selected XML element. Optionally change the insert mode (see below). Then click on the insert 
macro button  (above the macro preview tree) or use the shortcut Ctrl-M. Note that since it is 
possible to have two XML files open at the same time, the GMT distinguish between active side (orange 
border) and inactive side (dark gray border) for determining in which side a macro will be inserted.  
a) Insert Mode: Like for inserting single elements (see section 4.1/1), several different insert 

modes are available for inserting macros. But since "Convert" and "Wrap" don’t make 
sense regarding macros, the macro insert modes are: Insert Into, Insert After, Insert Before, 
Replace. If the current macro cannot be inserted according to the currently selected insert 
mode, the GMT automatically switches to the next valid insert mode (if there is one). 

b) Attribute Input: If a macro is inserted that contains elements with attributes containing a 
special value (%INPUT%, see Appendix D: The Macro Language), a dialog is shown 
containing a special XML attributes table (similar to the one that is shown below the XML 
tree) where the user can enter all such attribute values.  

 
Fig. 12: Attributes Input Dialog 

2) Navigate: The are several ways to "navigate" through the content of a macro file: 
a) Links: A macro file may contain internal links to other groups (marked with a  icon), 

which can be activated either through double-clicking or by pressing enter. 
b) History: The macros structure view provides a history mechanism like the HTML view and 

the XML view. This means that the previously used macros can be selected using the 
"Back"  and "Forward"  buttons. This feature can be very useful, especially after using 
a group-link  (see above).  

c) Search View: Using the  button on the macros toolbar, the user can switch between the 
macros structure view and the macros search view (see Fig. 13). The search result lists all 
macros that contain the entered keyword in its name. 

 
Fig. 13: Macros Search View 

d) Insertable Macros View: The  button on the macros toolbar switches to the "Insertable 
Macros View", which shows a list of all macros of the entire macro files that are insertable 
into the current XML document according to the currently selected macro insert-mode. 
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7 HTML View 
The HTML view (see Fig. 14) is a simple HTML browser, which can distinguish between 
conventional HTML links and special GMT links. 

 
Fig. 14: HTML View 

There are a few limitations regarding the HTML view due to the really bad implementation of the 
Java HTML viewing component that is used: 

 The biggest problem is that the GMT extremely slows down, when loading large HTML files. 
 The GMT may hang, if the entire HTML file is selected and then "Remove Link(s) is invoked. 
 Undo/redo of creating or removing links does not work correctly multiple times if "Use GMT-
Link delimiter" is activated in preferences.  

8 Miscellaneous Features 
8.1 Undo / Redo 
Every action in the GMT that changes the content of one or both opened files (e.g. insert macro, 
remove XML node, …) can be revoked using the Undo feature (found in the Edit menu, in the Edit 
sub-menu of each context menu, or using the keyboard shortcut Ctrl-Z). To do the undone 
feature again (or to revoke undo) use the Redo feature (found in the Edit menu, in the Edit sub-
menu of each context menu, or using the keyboard shortcut Ctrl-Shift-Z). There is no limit for 
undo that means you can use the undo feature an arbitrary number of times, but note that if a file is 
closed, another file is opened or a new file is created, all undoable actions regarding the previous 
file are removed from the internal list of undoable actions. Undoing an action that induced a change 
in the other side (like creating a link) will also undo the change in the other side. 

8.2 Project  
A project combines two XML / HTML files (one for the left and one for the right side) and a macro 
file and therefore, projects facilitate the work with often used pairs or triples of files that belong 
together. If a project file is opened (using the File/Project/Open menu item), the files that are 
defined inside the project are loaded together. The name of the current project is always shown in 
the status bar (see Fig. 1, 4c).  
The GMT always maintains the correlation between the current project and the currently opened 
files. That means, if one filename of the opened files changes (either through saving under a new 
filename, creating a new file, opening another file or closing the current file), the GMT either adjust 
the project, unset the project (and keep the files open), or close the project (this behavior can be set 
in the preferences dialog, see Fig. 17). 
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When creating a new project (using the File/Project/New menu item), the Project Properties dialog 
(see Fig. 15) is shown, whereas the fields for the left, right and macros file are already filled in with 
the currently opened files. To subsequently show the project properties dialog, just double click on 
the project name label in the status-bar. 

 
Fig. 15: Project Properties Dialog 

8.3 XML-Languages 
The GMT has been designed to work with any XML language. The properties of an XML language 
can be defined in the "XML Languages Properties Dialog" (which can be shown using the menu 
item of the same name in the file menu). 

 
Fig. 16: XML Languages Properties Dialog 

See the integrated help file for more information about XML languages. 

9 Future Work 
Here is a list of features that are planned for future releases: 

• Search & Replace in XML view and Search in HTML view 
• Advanced Search for macros 
• Drag-and-Drop of XML nodes 
• Overlapping links in HTML view 
• Visualization: using XSLT stylesheets to produce HTML, PDF or SVG reports 
• Links to / from images in HTML 
• Macros Editor 
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Appendix A: Keyboard Shortcuts 
It has been tried to define keyboard shortcuts for all features, so it should be possible to work 
almost without the mouse (except from activating links and selecting text in the HTML view).  
 

 I/O - Actions (only available when XML-Tree or HTML-View has focus): 
• Open XML- / HTML – File … <Ctrl-O> 
• Reload current file … <Ctrl-Shift-R> 
• Save current XML- / HTML – File … <Ctrl-S>  
• Save current XML- / HTML – File under new name… <Ctrl-Shift-S> 
• Create new empty XML document of current XML-Language… <Ctrl-N> 
 

 XML-Editor actions (Actions available when XML-Tree has focus): 
• Remove current Node … <Del> 
• Duplicate current Node ... <Ctrl-D> 
• Change value of Comment/Text-Node … <F2> 
• (Re-)Validate current XML-Document … <F4> 
• Show "Insertable Nodes" dialog … <Ctrl-I> 
• Show "All Elements" dialog … <Ctrl-A> 
• Show all Elements dialog … <Ctrl-A> 
• Show/Hide XPath-Bar … <Ctrl-Shift-X> 
• Show/Hide Treepath-Bar … <Ctrl-Shift-T> 
• Clipboard: 

 Cut current XML-Node … <Ctrl-X> 
 Copy current XML-Node … <Ctrl-C> 
 Paste "XML-Clipboard" content into current element … <Ctrl-V>  
 Paste "XML-Clipboard" content before current node … <Ctrl-Shift-V> 
 Paste "XML-Clipboard" content after current node … <Ctrl-Alt-V>  
 Replace current node with "XML-Clipboard" content … <Shift-Alt-V> 

• Folding: 
 Expand all descendants … <Ctrl-Alt-E> 
 Collapse all descendants … <Ctrl-Alt-C> 

 
 Navigation in any XML-Tree (also Macro-Preview-Tree): 
• Go to node above … <Down>, Go to node below … <Up> 
• Scroll one page up and select topmost node … <PageUp> 
• Scroll one page down and select bottommost node … <PageDown> 
• Scroll to and select first node … <Home>, Scroll to and select last node … <End> 
• Select next node starting with specific character  … <Any-character-key> 
• Go to parent node and collapse … <Left> 
• Go to next node (first child or next sibling) … <Right> 
• Toggle folding … <Space> 
• Go to parent element … <Alt-Up> 
• Go to next sibling … <Ctrl-Down>, Go to preceding sibling … <Ctrl-Up> 
• Go to first sibling … <Ctrl-Home>, Go to last sibling … <Ctrl-End> 
• Go Back … <Ctrl-Alt-Left> (only main XML view) 
• Go forward … <Ctrl-Alt-Right> (only main XML view) 
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 Navigation in any List-Box (Macros Structure View and Insertable Elements Dialog): 
• Go to list entry above … <Down>, Go to list entry below … <Up> 
• Scroll one page up and select topmost list entry … <PageUp> 
• Scroll one page down and select bottommost list entry … <PageDown> 
• Scroll to and select first list entry … <Home>, Scroll to and select last list entry … <End> 
• Select next list entry starting with specific character  … <Any-character-key> 
 

 Macros Structure View List-Boxes: 
• Insert current macro / Activate current group-link … <Enter> 
• Go to left list-box … <Left>, Go to right list-box … <Right> 
 

 Change View actions: 
• Switch to XML/HTML view … <F5> 
• Switch to syntax-highlighted source view … <F6> 
• Switch to plain-text source view … <F7> 
• Available only for XML files with DocType entry: 

 Switch to DTD report view … <F8> 
 Switch to syntax-highlighted DTD source view … <F9> 
 Switch to plain-text DTD source view … <F10> 

• Maximize (one step) current XML/HTML view … <F11> 
• Minimize (one step) current XML/HTML view … <F12> 
• Move divider of any split-pane: 

 activate … <Ctrl-F2> 
 move … cursor keys / <Home> / <End> 

• Activate and change focus to other side … <Tab> 
• Change focus between XML-Tree and Attributes-Table … <Ctrl-Tab> 

 
 Global shortcuts: 
• Undo last action … <Ctrl-Z>, Redo last action … <Ctrl-Shift-Z>  
• Insert current macro in current XML-document according to insert mode … <Ctrl-M> 
• Change macro insert-mode: 

 Switch to "Insert As Child" – mode … <Ctrl-Shift-M> 
 Switch to "Insert Before" – mode … <Ctrl-Alt-M> 
 Switch to "Insert After" – mode … <Alt-Shift-M> 
 Switch to "Replace" – mode … <Ctrl-Alt-Shift-M> 

• Save-All … <Ctrl-Shift-A> 
• Project:  

 New-Project … <Ctrl-Shift-N>  
 Open-Project … <Ctrl-Shift-O> 
 Project-Properties … <Ctrl-P> 

• Show XML-Language Definitions – Dialog … <Ctrl-L> 
• Show Preferences – Dialog … <Ctrl-Shift-P> 
• Quit GMT … <Ctrl-Q> 
• Show Help … <F1> 
• Refresh display (should solve display problems) … <Ctrl-Alt-R> 
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Appendix B: Preferences 
The GMT has been designed to be fully configable. Using the Preferences dialog (shown by the 
menu item of the same name in the File menu or using Ctrl-Shift-P) the user can adjust the 
behavior and appearance. The preferences will be maintained in gmt.preferences, a simple key-
value text-file, in the GMT main directory. There are five different categories of preferences: 
general preferences (see Fig. 17), preferences regarding HTML (see Fig. 18), preferences regarding 
XML (see Fig. 19), preferences regarding macros (see Fig. 20) and preferences that affect the 
appearance of the GMT (see Fig. 21). 

 
Fig. 17: Preferences Dialog – General Tab 

 
 

 
Fig. 18: Preferences Dialog – HTML Tab 
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Fig. 19: Preferences Dialog - XML Tab 

 

 
Fig. 20: Preferences Dialog - Macros Tab 
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Fig. 21: Preferences Dialog - Appearance Tab 

 

Appendix C: Menu Bar 
Since all features of the GMT are available via the menu bar or the context menus, this section 
gives a good overview of all available features. Note that features, which appear multiple times – in 
menu bar, context menu or toolbar –, have always the same icon. 
 
• File Menu: 

 
 Save all changed files. 
 Project submenu 
 Show the XML-Language dialog (see sect. 8.3). 
 Show the Preferences dialog (see section 8.3). 
 Quit the Guideline Markup Tool. 

 
 File / Project Submenu:  

 Create a new project using currently opened files. 
 Show the project file Open-dialog. 
 Show a list of previously opened project files. 
 Show a list of previously used directories. 
 Close the current project and all project files. 
 Show the project properties dialog (see sect. 8.2). 
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• Edit Menu: 
 

 Undo last action. 
 Redo last undone action (= undoes last Undo-action). 
 Cut current XML node to internal clipboard. 
 Copy current XML node to internal clipboard. 
 Submenu providing 4 paste actions (see below). 
 Show "Insertable Nodes" dialog. 
 Show "All Elements" dialog. 

 
 Edit / Paste Submenu:  

 Paste last copied node as last child into current element. 
 Paste last copied node before current node. 
 Paste last copied node after current node. 
 Replace current node with last copied node. 

 
• Left / Right Menu: 

 
 Creates a new empty XML file (ToolBar). 
 Creates a new XML file based on a template (TB). 
 Shows the Open File-dialog (TB). 
 Shows a list of previously opened files (TB). 
 Shows a list of previously used directories. 
 Reloads the current file (TB). 
 Loads the last backup of the current file. 
 Closes the current file. 
 Saves the current XML file (TB). 
 Saves the current XML file under a new name (TB). 
 Shows a list of available XML languages. 
 XML / View submenu (see below). 
 Creates a new GMT link. 
 Synchronize this link with link in other side. 
 Activate all "selected" links. 

 Remove the currently selected XML node. 
 Duplicate the currently selected XML node. 
 Change the text value of the current Comment / Text node. 
 Validates the current element and its descendants. 

 Remove the currently selected GMT link(s). 
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 View Submenu: 
 Change View sub-menu (see below). 

 Highlight sub-menu (see below). 
 Folding sub-menu (see below). 
 Filter sub-menu (see below). 
 Info-Extraction sub-menu (see below). 
 Icons sub-menu (see below). 
 Links Visualization sub-menu (see below). 
 Show/Hide XPath-Bar. 
 Show/Hide Treepath-Bar. 

 
▬ View / Change View Sub-menu: 

 Switch to Tree View (default). 
 Switch to syntax-highlighted Source View. 
 Switch to plain-text Source View. 

 Switch to DTD HTML report. 
 Switch to syntax-highlighted DTD Source View. 
 Switch to plain-text DTD Source View. 
 Maximize current view stepwise. 
 Minimize current view stepwise to default. 

▬ XML / View / Highlight Sub-menu: 
 Highlight all links in current XML/HTML file. 
 Highlight all links with same link id as current link. 
 Highlight result of XPath expression. 
 Show list of pre-defined Highlight-definitions. 

 
▬ XML / View / Folding Sub-menu: 

 Expand all nodes. 
 Collapse all nodes. 
 Expand all descendants of current node. 
 Collapse all descendants of current node. 
 Expand only result of XPath expression. 
 Collapse only result of XPath expression. 
 Show list of pre-defined Folding-definitions. 

 
▬ XML / View / Filter Sub-menu: 

 Show/Hide document node (= root node). 
 Show/Hide comment nodes. 
 Show/Hide text nodes.  
 Show/Hide CDATA nodes. 
 Show/Hide processing-instruction nodes. 
 Show only those nodes that are matched by XPath-expr. 
 Hide those nodes that are matched by XPath-expr. 
 Cancel any previously set filter. 
 Show list of pre-defined filters. 
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▬ XML / View / Info-Extraction Sub-menu: 
 Apply XSL file with information extraction instructions. 
 Unload previously applied XSL file. 
 Show list of pre-defined XSL files. 

 
▬ XML / View / Icon-Sets Sub-menu: 

 Switch back to default tree node icons. 
 Use icons from directory "icons1". 

 
▬ XML / View / GMT-Links Visualization Sub-menu: 

 Highlight all links and all descendants of their parents. 

 Macros Menu:

 Highlight all links and all ancestors of their parents. 
 

•  
 

 Show the Macros file Open-dialog (TB). 
les (TB). 

elow). 
). 

 

 Macros / View submenu:

 Show a list of previously opened Macro fi
 Show a list of previously used directories. 
 Reload the current Macro file (TB). 
 Close the current Macro file. 
 Macros / View submenu (see b
 Insert the currently selected macro (TB
 Change macro insert mode (TB). 

 

 Macro Preview submenu (see below). 
 Switch to Structure View (default). 
 Switch to Macros Search View. 
 Switch to Macros Insertable View. 

▬ Macros / View / Preview submenu: 
 Switch to tree pre-view (default). 

e pre-view. 

• Help Menu:

 Switch to syntax-highlighted sourc
 Switch to plain-text source pre-view. 

 
 

 

 Show the internal GMT help. 
low). 

line. 
c problems. 

 Help / WWW submenu (see be
 Check if a new version is available on
 Re-Initialize all components to solve graphi
 Reset the layout to the default. 
 Show the About dialog. 

 Help / WWW submenu: 

 Open the system-default browser with the GMT main site. 
 Open the system-default browser with the GMT help site. 
 Open the system-default browser with the Asgaard site. 
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Appendix D: The Macro Language 
This section gives only a short overview about the macro language. If you want to write your own 
macro file, have a look at the macro page1 of the GMT website.  

D.1 The Document Type Definition (DTD) 
<!-- gmt-macros is the root element - it must have exactly 2 children: macros-
def and structure-def (=the top level group) --> 
<!ELEMENT gmt-macros (macros-def, structure-def)> 
<!-- This attribute is not used in the current release. It is intended to 
specify the XML-Language. --> 
<!ATTLIST gmt-macros lang-id CDATA #IMPLIED> 
<!-- This attribute is not used in the current release. It can be used to 
specify a description of this macros file. --> 
<!ATTLIST gmt-macros description CDATA #IMPLIED> 
 
<!-- Macros definition part: --> 
 
<!-- the macros-def element contains all macro definitions: at least one 
macro-group or one macro --> 
<!ELEMENT macros-def ((macros-group | macro)+)> 
 
<!-- with the macros-group element macros - which belongs togehter - can be 
combined; macros-group's are currently not shown in the macros view of the GMT 
- they are only useful when editing a macros file in a XML editor --> 
<!ELEMENT macros-group ((macros-group | macro)+)> 
<!-- name of the macros-group --> 
<!ATTLIST macros-group name CDATA #IMPLIED> 
<!-- description of the macros-group --> 
<!ATTLIST macros-group description CDATA #IMPLIED> 
 
<!-- the macro element defines a macro (i.e. a structure of XML elements  
 which belongs togehter); a macro may contain one or more references  
 to elements, other macros or to the special link-def "macro" --> 
<!ELEMENT macro (constant-def*, (element-ref | text-node | comment-node | 
macro-include | GMT-LINK | GMT-LINK_EXT)+)> 
<!-- the name of this macro --> 
<!ATTLIST macro name ID #REQUIRED> 
<!-- an optional description for this macro - it will appear in the GMT as  
 a tooltip when the mouse is over the list element in the structure view --> 
<!ATTLIST macro description CDATA #IMPLIED> 
<!-- indicates if the XML document stays valid after this macro is inserted 
(true) or if further macros/elements have to be inserted to this macro (false) 
--> 
<!ATTLIST macro standalone (true | false) "true"> 
 
<!-- with the element-ref element you can define an element which  
 may have attributes and can contains other elments; in the current version  
 the GMT will not check if this is an valid element --> 
<!ELEMENT element-ref (attribute-ref | element-ref | text-node | comment-node 
| macro-include | GMT-LINK | GMT-LINK_EXT)*> 
<!-- the name of the referenced element --> 
<!ATTLIST element-ref name NMTOKEN #REQUIRED> 
 
<!-- with the attribute-ref element you can define an attribute for the 
element which is defined with the surrounding element-ref element; the GMT 
will not check if the name and the value of this attribute is valid for the 
element --> 
<!ELEMENT attribute-ref EMPTY> 
<!-- the name of this attribute --> 
<!ATTLIST attribute-ref name NMTOKEN #REQUIRED> 
<!-- the value of this attribute - currently there are special "text-macros" 
for attributes (and text-/comment-nodes) interpreted by the GMT: 
      %INPUT% - the user is asked for a value - if the user cancels the input, 
           the attribute won't be inserted; 

                                                 
1 http://www.asgaard.tuwien.ac.at/~peter/GMT/macros/ 

http://www.asgaard.tuwien.ac.at/~peter/GMT/macros/
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      %TEXT% - if text in the other side is selected the selected text will be  
           used as the value, otherwise the attribute won't be inserted, 
      %DATE% - will be replaced with the current date,  
      %TIME% - will be replaced with the current time, 
      %USER% - will be replaced with the current user (is not fully supported 
yet), 
      %LINK-ID% - will be replaced with the (next) link id, which will also be  
           used in the HTML link in the HTML view - is used in link-def 
      $CONST_NAME$ - will be replaced with the text-value of string constant 
CONST_NAME; the first time a constant is accessed user input is required; if 
its is in upper case characters it is a global constant, otherwise it is local 
(only valid in current macro) 
      #COUNTERNAME# - will be replaced with "#COUNTERNAME{successive number}", 
e.g. #A-000# = #A-001, #A-002, #A-003;  ## = #1, #2, #3  
      {XPath-Expression} - will be replaced by the result of the XPath 
expression applied to the selected element in the current file 
      [XPath-Expression] - will be replaced by the result of the XPath 
expression applied to the selected element in the other file --> 
<!ATTLIST attribute-ref value CDATA #REQUIRED> 
<!-- defines a default value - makes only sense if used together with 
'%INPUT%' as value --> 
<!ATTLIST attribute-ref default-value CDATA #IMPLIED> 
 
<!-- creates a text-node (PCDATA) --> 
<!ELEMENT text-node EMPTY> 
<!-- the value of this text-node; see attribute-ref for special values --> 
<!ATTLIST text-node value CDATA #REQUIRED> 
<!-- defines a default value - makes only sense if used together with 
'%INPUT%' as value --> 
<!ATTLIST text-node default-value CDATA #IMPLIED> 
 
<!-- creates a comment-node --> 
<!ELEMENT comment-node EMPTY> 
<!-- the value of this comment-node; see attribute-ref for special values --> 
<!ATTLIST comment-node value CDATA #REQUIRED> 
<!-- defines a default value - makes only sense if used together with 
'%INPUT%' as value --> 
<!ATTLIST comment-node default-value CDATA #IMPLIED> 
 
<!-- defines a string constant which can be used inside the value-attribute of  
     attribute-ref, text-node and comment-node elements using $CONST_NAME$ or 
$const_name$ --> 
<!ELEMENT constant-def EMPTY> 
<!-- name of the constant to be defined --> 
<!ATTLIST constant-def name CDATA #REQUIRED> 
<!-- value of the constant; see attribute-ref for special values --> 
<!ATTLIST constant-def value CDATA #REQUIRED> 
 
<!-- copies the content of the referred macro into the current macro --> 
<!ELEMENT macro-include EMPTY> 
<!-- name of the referred macro --> 
<!ATTLIST macro-include name IDREF #REQUIRED> 
 
<!-- will be replaced by <gmt-link link-id="%LINK-ID%"/> --> 
<!ELEMENT GMT-LINK EMPTY> 
<!-- will be replaced by <gmt-link link-id="%LINK-ID%" comment="%INPUT% 
%TEXT%" created-at="%DATE%, %TIME%" created-by="%USER%"/> --> 
<!ELEMENT GMT-LINK_EXT EMPTY> 
 
<!-- Structure definition part: --> 
 
<!-- structure-def contains the root-group of the macros structure as shown in 
GMT's structure view --> 
<!ELEMENT structure-def (group | group-include | group-link | macro-ref | 
single-element-ref | separator | label)+> 
<!-- a group contains one or more sub-groups, group-refs, macro-refs or 
single-element-refs --> 
<!ELEMENT group (group | group-include | group-link | macro-ref | single-
element-ref | separator | label | macros-group-include)*> 
<!-- the name of this group --> 
<!ATTLIST group name CDATA #REQUIRED> 
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<!-- an optional description for this element - will appear in the GMT as a 
tooltip when the mouse is over the list element in the structure view --> 
<!ATTLIST group description CDATA #IMPLIED> 
 
<!-- with macro-ref you can refer to an existing macro; if a macro-ref element 
is used in a macro definition(i.e. in a macro or element-ref element), the 
macro-ref element will be replaced with the contents of the refered macro --> 
<!ELEMENT macro-ref EMPTY> 
<!-- the name of an existing macro --> 
<!ATTLIST macro-ref name IDREF #REQUIRED> 
<!-- the optional label attribute can be used to define a different label  
 (instead of the name) for the list-item in the structure view of the GMT --> 
<!ATTLIST macro-ref label CDATA #IMPLIED> 
 
<!-- with group-include you can include an existing group (i.e. defined 
somewhere else in the structure definition part); in the GMT it looks the same 
as the refered group (it seems that the refered group is defined twice) --> 
<!ELEMENT group-include EMPTY> 
<!-- the name of an existing group --> 
<!ATTLIST group-include name CDATA #REQUIRED> 
<!-- the optional label attribute can be used to define a different label  
 (instead of name) for the list-element in the structure view of the GMT --> 
<!ATTLIST group-include label CDATA #IMPLIED> 
 
<!-- inserts a new group with containing the macros of referenced macros-
group; convenient way to quick add new macros --> 
<!ELEMENT macros-group-include EMPTY> 
<!-- name of macros-group to be included --> 
<!ATTLIST macros-group-include name CDATA #REQUIRED> 
 
<!-- represents a link to a group --> 
<!ELEMENT group-link EMPTY> 
<!-- the name of an existing group --> 
<!ATTLIST group-link name CDATA #REQUIRED> 
<!-- the optional label attribute can be used to define a different label  
 (instead of name) for the list-element in the structure view of the GMT --> 
<!ATTLIST group-link label CDATA #IMPLIED> 
<!-- description for this group-link - will be shown as tooltip --> 
<!ATTLIST group-link description CDATA #IMPLIED> 
 
<!-- unlike element-ref a single-element-ref is used to define only a single 
element it's the same as a macro-ref refering to a macro with only a single 
element-ref; if you want to define attributes with to single element, you have 
to use macro-ref/macro --> 
<!ELEMENT single-element-ref EMPTY> 
<!-- the name of the element --> 
<!ATTLIST single-element-ref name NMTOKEN #REQUIRED> 
<!-- an optional description for this element - will appear in the GMT as a 
tooltip when the mouse is over the list element in the structure view --> 
<!ATTLIST single-element-ref description CDATA #IMPLIED> 
<!-- indicates if the XML document stays valid after this element is inserted 
(true) or if further macros/elements have to be appended to this element 
(false) --> 
<!ATTLIST single-element-ref standalone (true | false) "true"> 
 
<!-- inserts a separator (line) - use this to group macros/elements which 
belong together --> 
<!ELEMENT separator EMPTY> 
 
<!-- inserts a label - useful together with separator to describe a part of a 
group --> 
<!ELEMENT label EMPTY> 
<!-- the text of the label --> 
<!ATTLIST label text CDATA #REQUIRED> 
<!-- description for this label - will be shown as tooltip --> 
<!ATTLIST label description CDATA #IMPLIED> 
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D.2 Sample Macros 
Some samples taken from the 8HB macro file: 
 
Macros Source Result (in 8HB) 
<macro name="ChunkGroup"> 
   <element-ref name="chunk-group"> 
      <attribute-ref name="title" value="%TEXT%"/> 
   </element-ref> 
</macro> 

<chunk-group title="..."/> 

Note: %TEXT% will be replaced with the currently selected text in the other side. 
<macro name="Chunk"> 
   <element-ref name="chunk"> 
      <attribute-ref name="chunk-id"  
            value="#CHUNK-00000#"/> 
      <macro-include name="Structure"/> 
   </element-ref> 
</macro> 

<chunk chunk-id="#CHUNK-..."> 
   <structure status="..."/> 
</chunk> 

Note: #CHUNK-00000# will be replaced with #CHUNK-00001, #CHUNK-00002, #CHUNK-00003#, ... 
<macro name="Structure"> 
   <element-ref name="structure"> 
      <attribute-ref name="status"  
            value="%INPUT%narrative"/> 
   </element-ref> 
</macro> 

<structure status="..."/> 

Note: %INPUT%narrative will be replaced with a user-entered value; defaults to narrative. 
<macro name="definition"> 
   <element-ref name="definition"> 
      <attribute-ref name="name" value="%INPUT%"/> 
      <attribute-ref name="description" value="%TEXT%"/> 
      <GMT-LINK/> 
   </element-ref> 
</macro> 

<definition name="..."  
         description="..."> 
   <gmt-link link-id="..."/> 
</definition> 

Note: <GMT-LINK/> will be replaced with the GMT link element. 
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